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System Requirements 
Before installing Parallels Client on your Windows computer, please make sure that your system 
meets the following requirements: 

• Windows XP SP3, Vista, Windows 7, Windows 8, Windows 10. 

• The same hardware requirements as specified by Microsoft for the above versions of Windows. 

• Some features (high color graphics, sound, etc.) will only be available if your Windows computer 
has the appropriate hardware installed and is properly configured. 

Installing Parallels Client Using an Invitation Email 
Your system administrator will send you an invitation email with the instructions on how to install 
Parallels Client for Windows and configure a Parallels Remote Application Server connection. The 
invitation email will contain the following information and action links: 

• A message from your system administrator. 

• A link to download Parallels Client for Windows (links to Parallels Client for other platforms may 
also be included if you are using other devices in addition to a Windows computer). 

• A link to automatically configure Parallels Client on your computer, so you can connect to the 
Parallels Remote Application Server. 

• Parallels Remote Application Server connection properties. You can use this information to 
manually create a Parallels Remote Application Server connection. The automatic configuration 
via the link (see above) is the preferred and the easiest method, but you can use this information 
to create a connection manually if needed for any reason. 

To install Parallels Client for Windows using an invitation email: 

1 Make sure you are logged into your computer as a user with administrative privileges. 
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2 In the invitation email, click the Windows thumbnail to download Parallels Client for Windows 
installer. 

3 When the download is complete, go to your download folder and run the 
ClientDownloader.exe file that you just downloaded. This is actually a small utility that 
detects the version of Windows that you are running and then downloads the appropriate 
Parallels Client for Windows installer. 

4 When the download is complete, the Parallels Client installation wizard will automatically start. 

5 On the Welcome page of the installation wizard, click Next. 

 

6 Accept the License Agreement and click Next. 

7 Select the folder where you want to install Parallels Client and click Next. 
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8 The SSO Installation page will be skipped when installing Parallels Client on a Windows Server 
operating system. On all other supported versions of Windows, it will be shown. Use the page 
to specify whether you want to install the Single Sign-On component. The component will 
automatically use your credentials to connect to Parallels Remote Application Server. Please 
note that you will need to reboot your computer (or log off and then log on again) after the 
installation for the component to work. 

 

9 Click Next. 

10 On the Ready to Install page, click Install. 
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11 Once the installation is complete, you'll see the final wizard page.  

 

12 Clear the Launch Parallels Client option (we don't want to start the program just yet) and click 
Finish to close the wizard. 

You now need to configure Parallels Client, so it can connect to Parallels Remote Application 
Server. The invitation email that you received from your system administrator includes a link that 
can accomplish this task automatically. Please follow the instructions below to configure Parallels 
Client. 

To configure Parallels Client for Windows: 

1 In the invitation email, find the Configure section and click the Click Here to auto configure 
the downloaded client link. 
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2 The link will open in a web browser after which you should see the following dialog: 

 

3 Make sure the TSClient Application item is selected and click OK. This will configure Parallels 
Client for Windows and then will display the Logon screen. 

 

4 Select the Authentication Type from the following:  

• Credentials. Select this option to connect to Parallels Remote Application Server by 
supplying your credentials, such as your domain user name and password. 

• Smart card. Select this option to connect to Parallels Remote Application Server using a 
smart card. 
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• Single Sign-On. This option will be included in the list only if the Single Sign-On module is 
installed during Parallels Client installation. Select this option to use local system credentials 
to connect to the remote server.   

Note for Administrators: The allowed authentication type(s) must be specified in the RAS Console in 
Connection / Authentication. 

5 Depending on the authentication type selected, type your user name and password or insert a 
smart card into a reader. If using a smart card, enter a PIN when prompted. 

6 Click Connect. 

You should now see the main Parallels Client window. The left pane of the window displays the 
connection that was automatically configured for you.The right pane displays published resources 
that you can use.  

 

Double-click a resource to open it. The resource will open in a separate window on your local 
computer as if it was a local application or a document (or a remote desktop if one is available as a 
published resource).  
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Installing Parallels Client Manually 

Manually Downloading and Installing Parallels Client 

The preferred method of downloading and installing Parallels Client for Windows is via an invitation 
email as described in the previous section. If you would like to download the installer, so you can 
run it manually on a different computer or for any other reason, please use the following URLs: 

• 32 bit version: http://download.parallels.com/ras/v15/RASClient.msi 

• 64 bit version: http://download.parallels.com/ras/v15/RASClient-x64.msi 

To install Parallels Client for Windows: 

1 Make sure you are logged into your computer as a user with administrative privileges. 

2 Run the Parallels Client installer that you've downloaded from the Parallels website. 

3 On the Welcome page of the installation wizard, click Next. 

 

4 Accept the License Agreement and click Next. 

5 Select the folder where you want to install Parallels Client and click Next. 
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6 The SSO Installation page will be skipped when installing Parallels Client on a Windows Server 
operating system. On all other supported versions of Windows, it will be shown. Use the page 
to specify whether you want to install the Single Sign-On component. The component will 
automatically use your credentials to connect to Parallels Remote Application Server. Please 
note that you will need to reboot your computer (or log off and then log on again) after the 
installation for the component to work. 

 

7 Click Next. 

8 On the Ready to Install page, click Install. 
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9 When the installation is complete, you'll see the final wizard page.  

 

10 Click Finish to close the wizard and start Parallels Client for Windows. 

Connecting to Parallels Remote Application Server 

After you manually install Parallels Client and run it for the first time, you'll be asked if you would like 
to configure a new connection. Click Yes. This will open the New connection dialog. 
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Your system administrator should give you the connection information that must be specified in this 
dialog. If you received an invitation email from your administrator, you can find this information at 
the bottom of the message. The information will look similar to the following: 

To manually configure the RAS Connection, use the following settings: 
 
Server: 192.168.1.102 
Port: 443 
Connection Mode: Gateway Mode 

To specify the connection properties: 

1 In the Server field, enter the Parallels Remote Application Server IP address or hostname (this 
should be the server where the RAS Secure Client Gateway resides). 

2 In the Connection mode field, select one of the following options (please note that as a user, 
you don't have a choice here and must use the mode that your system administrator has asked 
you to use): 

• Gateway Mode. Parallels Client connects to the RAS Secure Client Gateway and the 
session connection is tunneled through the first available connection. This mode is ideal for 
servers that are only reachable via the gateway and do not require a high level of security. 

• Gateway SSL Mode. Same as the gateway mode above, but uses encryption to secure the 
data. 

• Direct Mode. Parallels Client first connects to the RAS Secure Client Gateway for the best 
available terminal server and then connects directly to that server.  This is best used when 
the Parallels Client and the terminal server reside on the same network. 

• Direct SSL Mode. Same as the direct mode above, but uses encryption to secure the data. 

If your administrator enabled the Broadcast RAS Secure Client Gateway Address option for 
the gateway, you can click the [...] button and should see the available Parallels Remote 
Application Server connection in your area, which you can select. If no connections are 
displayed, then you need to enter the Server information manually, as described above. 

3 In the Friendly name field, choose and type a friendly name for this connection. 

4 If your system administrator told you to specify the port number, do the following: 

a Click the Advanced settings link. The Connection Properties dialog opens (see the 
screenshot below). 

b Specify the port number in the Port field. 
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c While here, you can review and modify other properties if you wish. More on these later in 
this guide. 
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5 Click OK. The Logon dialog opens. 

 

6 In the Authentication type drop-down list, select the desired method of authentication: 

• Credentials. Select this option and then enter your username and password. You will be 
authenticated on the remote server using the specified credentials. 

• Smart Card. Select this option to authenticate using a smart card. When connecting to the 
remote server, insert a smart card into the card reader and then enter a PIN when 
prompted. 

• Single Sign-On. This option will be included in the list only if the Single Sign-On module is 
installed during Parallels Client installation. Select this option to use local system credentials 
to connect to the remote server 

Note for Administrators: The allowed authentication type(s) must be specified in the RAS Console in 
Connection / Authentication. 
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7 Click Connect. If the connection is successful, you'll see the main Parallels Client window. 
The left pane of the window displays your connection(s) and published folders.The right pane 
displays published resources that you can use. 

 

Advanced Parallels Client Installation 

Note: This section is intended for IT Administrators. If you are not an IT administrator in your 
organization, you may skip it. 

The Parallels Client for Windows installer uses the MSI format. This enables you to deploy it 
remotely using Group Policies or any other deployment tool that can work with MSI installers.   

There are two ways to modify the client installation settings: 

• Modify the original file using Orca.exe. 

• Run the installer from the command line: msiexec.exe /i RASClient.msi (or 
RASClient-x64.msi if using a 64 bit version)  

Silent Install 

To perform a silent install, run the following command: 

msiexec.exe /qn /i RASClient.msi  
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In the command above, specify RASClient-x64.msi if using a 64 bit version of Parallels Client 
for Windows. 

General Settings 

When running an installation command specified above, you can pass the following properties to 
msiexec.exe using the PROPERTY=VALUE notation: 

DEFSETTINGS: To use when Parallels Client installer reads 2xsetting.2xc (the file containing all 
settings to be used by the client) as default settings. 

DEFSETTXML: To use when XML settings are entered manually. 

OVERRIDEUSERSETTINGS: To override the user settings with client MSI settings. 

• 0 – Client settings are not overridden 

• 1 – Client settings are overridden with the new settings of the Client MSI setup. 

DISABLEOPTIONS: To disable the Options button and hide the options to configure the client 
settings. This option can be applied to users without administrative rights. 

• 0 – Options are enabled 

• 1 – Options are disabled 

DISABLEOPTIONSADMIN: To disable the Options button and hide the options to configure the 
client settings. This option can be applied to users with administrative rights. 

DISABLESAVEPASSWORDADMIN: To disable the clients from saving the password even if they 
have administrative rights. 

• 0 – Option to save password is enabled 

• 1 – Option to save Password is disabled 

DISABLESAVEPASSWORD: To disable the clients from saving the password. This option is ignored 
with users with administrative rights. 

• 0 – Option to save password is enabled 

• 1 – Option to save Password is disabled 

TUXGINA: Exclude/Include SSO during a silent installation 

• 0 – Install SSO 

• 1 – Exclude SSO 

• 2 – Prompt during installation [Default] 

TUXGINASRV: Install SSO on both Client and Server 

• 0 – Install SSO only on the Client 
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• 1 – Install SSO on both Client and Server 

Using Active Directory 

There are two different ways that you can deploy an application through Active Directory. You can 
either publish the application or you can assign the application. 

You can publish applications to users only, but you can assign applications to either users or 
computers. The applications are deployed in different ways, depending on which method you 
decide to use. 

Parallels recommends that administrators assign the applications to COMPUTERS. The main 
reason is that the application is actually installed the next time the computer reboots. 

When assigning to users, the application is not installed until the user actually clicks on the icons 
created for the application. 

To assign an application to certain computers, simply do the following in Active Directory: 

1 Open the Group Policy Editor. 

2 To assign an application to a computer, navigate through the group policy console to Computer 
Configuration / Software Settings / Software Installation. Right-click the Software Installation 
container and click New > Package in the context menu. Select the appropriate MSI file and 
click Open. You are now asked whether you want to publish or assign the application. Select 
Assign and click OK. 

Please note that when doing a silent installation, the MSI can be deployed using the following 
syntax (for the 64 bit version, use RASClient-x64.msi): 

msiexec /qn /i RASClient.msi 

The following sample command installs Parallels Client using the DISABLESAVEPASSWORD=0 
option (enable the ability to save the password)  while skipping the SSO installation: 
msiexec /qn /i 2XClient.msi DISABLESAVEPASSWORD=0 TUXGINA=1 
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Adding a New Connection 
Parallels Client for Windows allows you to have more than one connection, so you could easily 
connect to different servers or using different connection properties, etc. 

To add a connection: 

1 Open Parallels Client by clicking Start > All Programs > Parallels > Client > Client (or double-
click the Parallels Client icon on your desktop). 

2 In the main Parallels Client window, click the File > New Connection menu item. The New 
Connection dialog opens. 

 

3 Specify a connection type you'd like to create: 

• Remote Application Server. Create a Parallels Remote Application Server connection. 

C H A P T E R  2  
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• Standard RDP. Create a standard Remote Desktop connection. This option completely 
bypasses Parallels Remote Application Server and will establish an RDP connection with any 
computer on your network that accepts Remote Desktop connections and to which you are 
allowed to connect. 

4 Click OK. The New connection dialog opens. 

 

When creating a Remote Application Server connection, your system administrator should give 
you the connection information that must be specified in this dialog. If you received an invitation 
email from your administrator, you can find this information at the bottom of the message. The 
information will look similar to the following: 

To manually configure the RAS Connection, use the following 
settings: 
 
Server: 192.168.1.102 
Port: 443 
Connection Mode: Gateway Mode 

When creating a Standard RDP connection, you need to know the IP address or hostname of 
the remote computer you want to connect to. 

5 In the Server field, enter the Parallels Remote Application Server IP address or hostname (this 
should be the server where the RAS Secure Client Gateway resides). If creating a Standard 
RDP connection, specify the remote computer IP address or hostname. 

6 The Connection mode drop-down list is enabled only when creating a Remote Application 
Server connection. Select one of the following options (please note that as a user, you don't 
have a choice here and must use the mode that your system administrator has asked you to 
use): 

• Gateway Mode. Parallels Client connects to the RAS Secure Client Gateway and the 
session connection is tunneled through the first available connection. This mode is ideal for 
servers that are only reachable via the gateway and do not require a high level of security. 

• Gateway SSL Mode. Same as the gateway mode above, but uses encryption to secure the 
data. 
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• Direct Mode. Parallels Client first connects to the RAS Secure Client Gateway for the best 
available terminal server and then connects directly to that server.  This is best used when 
the Parallels Client and the terminal server reside on the same network. 

• Direct SSL Mode. Same as the direct mode above, but uses encryption to secure the data. 

If your administrator enabled the Broadcast RAS Secure Client Gateway Address option for 
the gateway, you can click the [...] button and should see the available Parallels Remote 
Application Server connection in your area, which you can select. If the list is empty, you need 
to enter the Server information manually, as described above. 

7 In the Friendly name field, choose and type a friendly name for this connection. 

8 The Advanced settings link opens the Connection Properties dialog where you can specify 
additional connection properties. For more information, please see Configuring a RAS 
Connection (p. 22) or Configuring an RDP Connection (p. 33). 

9 Click OK to create a connection. 

Configuring a RAS Connection 
To view and modify the properties of an existing Remote Application Server connection, right-click 
it in the main Parallels Client window and then click Connection Properties in the context menu. 

 

This will open the Connection Properties dialog. Properties are grouped in the dialog by 
functionality using tab pages. The following subsections describe each tab page in detail. 
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Connection 

The Connection tab page allows you specify connection properties and logon information. 

 

Configuring the Primary Connection 

On the Connection tab page, you can define a primary connection and one or more secondary 
connections. 

The primary connection is what Parallels Client will use first to connect to the specified server. This 
should be the server where the primary RAS Secure Client Gateway is running.  

To specify the primary connection information: 
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1 In the Primary Connection field, specify the server name or IP address. You can click the [...] 
button and select a server from the list. If the server is not listed, it means that the system 
administrator disabled this functionality on the server side. In such a case, specify the server by 
typing its name or IP address in the Primary Connection field. 

Note for Administrators: The Broadcast RAS Secure Client Gateway Address option must be 
enabled on the server side for the [...] button to display the server. 

2 In the Connection Mode drop-down list, select one of the following options (once again, as a 
user, ask your system administrator which mode you should select): 

• Gateway Mode. Parallels Client connects to the RAS Secure Client Gateway and the 
session connection is tunneled through the first available connection. This mode is ideal for 
servers which are only reachable via the gateway and do not require a high level of security. 

• Gateway SSL Mode. Same as the gateway mode above, but uses encryption to secure the 
data. 

• Direct Mode. Parallels Client first connects to the RAS Secure Client Gateway for the best 
available terminal server and then connects directly to that particular server.  This is best 
used when the Parallels Client and the terminal server are on the same network. 

• Direct SSL Mode. Same as the direct mode above, but uses encryption to secure the data. 

3 In the Port field, specify the port on which the gateway listens for incoming connections. If the 
default value has been modified on the server side, you have to replace the default value here 
as well. Otherwise, leave the default value intact. 

4 In the Friendly Name field, choose and type a name of your choice, so you could easily identify 
the server in Parallels Client later. 

Configuring a Secondary Connection 

If the Remote Application Server that you are connecting to has more than one RAS Secure Client 
Gateway, you can define a secondary connection, which will be used as a backup connection in 
case the primary gateway connection fails. 

To add a secondary connection: 

1 Click the Secondary Connections button. 

2 In the Secondary Connections dialog, click the Add button and specify a server name or IP 
address. This should be a server hosting a secondary RAS Secure Client Gateway (the primary 
gateway is used by the primary connection). You can click the [...] button and select a server 
from the list. If none are available (or if the desired server is not in the list), type the server info in 
the field provided. 

3 Select the connection mode and modify the port number if necessary. Click OK. 

4 Back in the Secondary Connections dialog, if you have multiple secondary connections, you 
can move them up or down in the list. If the primary connection cannot be established, Parallels 
Client will use secondary connections in the order listed. 

5 Click OK. 



25 
 

Using Parallels Client for Windows 
 

Configuring the Logon Information 

In the Logon section, specify the following properties: 

1 Select the Auto Logon option to enable Parallels Client to connect automatically without 
displaying the Logon dialog every time you connect to a remote server. 

2 In the Authentication type drop-down list, select the desired method of authentication: 

• Credentials. Select this option and then enter the username, password, and domain 
information. You will be authenticated on the remote server using the specified credentials. 

• Smart Card. Select this option to authenticate using a smart card. When connecting to the 
remote server, insert a smart card into the card reader and then enter a PIN when 
prompted. 

• Single Sign-On. This option will be included in the list only if the Single Sign-On module is 
installed during Parallels Client installation. Select this option to use local system credentials 
to connect to the remote server.   

Note for Administrators: The allowed authentication type(s) must be specified in the RAS Console in 
Connection / Authentication. 
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Display 

The Display tab page allows you to configure display options. 

 

In the General Options section, specify the general display properties. 

Select the Use primary monitor only option to start published applications on your primary 
monitor only. Other monitors connected to your system will not be used. 

Specify the Desktop Options as follows: 

• Smart-sizing. Desktop smart sizing will scale a remote desktop to fit the connection window. 

• Embed desktop in launcher. Enable this option to access a published desktop inside Parallels 
Client. 

• Span desktop across all monitors. Enable this option to span published desktops across all 
connected monitors. 
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• Display connection bar in full screen mode. Enable this option to show the connection bar 
when connecting in full screen mode. 

Printing 

The Printing tab page allows you to configure printing options. 

 

In the Technology drop-down list, select the technology to use when redirecting printers to a 
remote computer: 

• None. No printer redirection will be used. 

• RAS Universal Printing technology. Select this option if you want to use RAS Universal 
Printing technology. 

• Microsoft Basic Printing Redirection technology. Select this option if you want to use 
Microsoft Basic printing technology. 

• RAS Universal Printing and Microsoft Basic redirection technologies. Select this option to 
use both Parallels RAS and Microsoft technologies. 
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RAS Universal Printing 

If you selected RAS Universal Printing technology, select printers to redirect in the Redirect 
Printers drop-down list:  

• All. All printers on the client side will be redirected. 

• Default only. Only the Windows default printer will be redirected.  

• Specific only. Select the printers to redirect from the provided list. The list becomes enabled 
only if you select this option. 

Additional options can be configured by clicking the Options button, which will open the RAS 
Universal Printing Options dialog. 

In this dialog, you can select the data format:  

• Portable Document Format (PDF). Adobe PDF. 

• Enhanced Meta File (EMF). Use vector format and embedded fonts. 

• Bitmap (BMP). Bitmap images. 

You can also choose to configure printer preferences before printing: 

• Never show the preference window. The printer preferences window will never be shown 
before printing. 

• Show Preference window for all printers. The printer preferences window will be shown for 
all printers before printing. 

• Show the preferences window only for the following printers. The printer preferences 
window will be shown for all selected printers in the list box which becomes enabled when this 
setting is selected. 

Default printer settings 

To configure default printer settings, click the Change Default Printer settings button. 

The default printer list shows printers that can be redirected by the client to the remote computer. 
The list also includes the printing technology that the available printers will use. The technology 
reflects the setting selected in the Technology section. For example, if the technology was set to 
RAS Universal Printing technology, only the printers using RAS Universal Printing will be listed. 

To disable the default printer, select <none>. To redirect the default local printer on the client side 
to the remote computer, select <defaultlocalprinter>. When <custom printer> is selected, you 
can specify a custom printer which might be installed on the remote computer. The first printer that 
matches the printer name inserted in the custom text box, will be set as the default printer on the 
remote computer. 
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Select Match exact printer name to match the name exactly as inserted in the custom text box. 
Please note that the remote printer name may be different than the original printer name. Also note 
that local printers may not redirect due to server settings or policies. 

You can specify the time a printer will be forced as default. If the default printer is changed during 
this time after the connection is established, the printer is reset as default. 

Select the Update the remote default printer if the local default printer is changed option to 
change the remote default printer automatically when the local default printer is changed. Please 
note that the new printer must have been previously redirected. 

Scanning 

On the Scanning tab page, you can specify a scanner that should be used when one is required 
by a published application. 

 

You can set the following options on the Scanning tab page: 
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• Use. Allows you to select a scanning technology. RAS Universal Scanning uses TWAIN and 
WIA redirection allowing an application to use either technology depending on the hardware 
type connected to the local computer. If you select None, scanning will disabled. 

• Redirect Scanners. Select scanners attached to your computer for redirection. You can select 
All (all attached scanners will be redirected) or Specific only (only the scanners you select in 
the provided list will be redirected). 

Local Resources 

Use the Local Resources tab page to configure how local resources are handled by a remote 
server.  

 

You can see that these are the same options that are available when using a standard Microsoft 
Remote Desktop Connection. The options are self-explanatory, so you can set them according to 
your preferences. 
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Experience 

The Experience tab page allows you to tweak the connection speed to optimize the performance 
of the connection with the remote server. 

 

If you are connecting to a remote server on a local network that runs at 100 Mbps or higher, it is 
usually safe to have all of the experience options turned on. It is also recommended to enable 
compression to have a more efficient connection. 

Network 

Use the Network tab page to configure a proxy server if you have to use one to connect to 
Parallels Remote Application Server. 

To configure a proxy server, select the Use proxy server option and then select the protocol from 
the following list: 
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• SOCKS4. Enable this option to transparently use the service of a network firewall. 

• SOCKS4A. Enable this option to allow a client that cannot connect to resolve the destination 
host’s name to specify it. 

• SOCKS5. Enable this option to be able to connect using authentication. 

• HTTP 1.1. Enable this option to connect using a standard HTTP 1.1 protocol connection. 

Specify the proxy host domain name or IP address and the port number. 

For SOCKS5 and HTTP 1.1 protocols, select Proxy requires authentication and enter user 
credentials. 

Authentication 

Use the Authentication tab page to specify what happens if the server authentication fails. 

In the If authentication fails drop-down list, select one of the following options: 

• Connect. The user can ignore the certificate of the server and still connect. 

• Warn. The user is alerted about the certificate and still has the ability to choose whether to 
connect or not. 

• Do not connect. The user is not allowed to connect. 

Advanced Settings 

The Advanced Settings tab page allows you to customize the default behavior or Parallels Client. 

You can specify the following properties: 

• Use client system colors. Enable this option to use the client system colors instead of those 
specified on the remote desktop. 

• Use client system settings. Enable this option to use the client system settings instead of 
those specified on the terminal server. 

• Create shortcuts configured on server. For each published application, the administrator can 
configure shortcuts that can be created on the client's desktop and the Start menu. Select this 
option to create the shortcuts, or clear the option if you don't want to create them. 

• Register file extensions associated from the server. For each published application, the 
administrator can create file extension associations. Use this option to either register the 
associated file extensions or not. 

• Redirect URLs to this computer. Enable this option to use the local web browser when 
opening 'http:" links. 

• Redirect Mail to this computer. Enable this option to use the local mail client when opening 
‘mailto:’ links. 
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• Always ask for credentials when starting applications. If this option is enabled, the user will 
be prompted to enter their credentials when starting applications. 

• Allow Server to send commands to be executed by client. Enable this option to allow 
commands being received from the server to be executed by the client. 

• Confirm Server commands before executing them. If this option is enabled, a message is 
displayed on the client to confirm any commands before they are executed from the server. 

• Network Level Authentication. Check this option to enable network level authentication, 
which will require the client to authenticate before connecting to the server. 

• Redirect POS devices. Enables the Point of Service (POS) devices such as bar code scanners 
or magnetic readers that are attached to the local computer to be used in the remote 
connection. 

• Use Pre Windows 2000 login format. If this option is selected, it allows you to use legacy 
(pre-Windows 2000) login format. 

Connection Advanced Settings 

Click the Connection Advanced Settings button to configure the following settings: 

• Connection Timeout. This is the amount of time the client will try to connect to the Parallels 
Remote Application Server until the connection is aborted. While the connection is being 
established, the connection banner will be shown. 

• Show Connection Banner if connection is not established within. Specifies the time period 
in seconds after which the connection banner will be displayed. 

• Show Desktop if published application does not start within. If a published application is 
not launched within the time period specified in this field, the server’s desktop will be loaded. 
This is helpful if an error occurs on the server while launching an application. By loading the 
server’s desktop, the error can be seen. 

• Reconnect if connection is dropped. Select this option and set the number of Connection 
Retries. If a connection is dropped, the Parallels Client will automatically try to reconnect. 

• Override computer name. Specifies the name that your computer will use during a remote 
desktop session. If set, this will override the default computer name. Any filtering set by the 
administrator on the server side will make use of the Override computer name. 

Configuring an RDP Connection 
To modify the properties of an existing standard RDP connection, right-click it in the main Parallels 
Client window and then click Connection Properties in the context menu. This will open the 
Connection Properties dialog. Properties are grouped in the dialog by functionality using tab 
pages. The following subsections describe each tab page in detail. 
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Connection 

The Connection tab page allows you specify connection settings and logon information. 

 

In the Connection Settings section, specify the following properties: 

3 In the Primary Connection field, specify the remote computer hostname or IP address.  

4 The Port field contains the TCP port 3389 by default, which is the standard port for RDP 
connections. You can modify it if the port number was changed on the remote computer. 

5 In the Friendly Name field, choose and type a name of your choice, so you could easily identify 
the server in Parallels Client later. 

In the Logon section, specify the following properties: 

1 Select the Auto Logon option to enable Parallels Client to connect automatically without 
displaying the Logon dialog every time you connect to a remote server. 

2 In the Authentication type drop-down list, select the desired method of authentication: 
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• Credentials. Select this option and then enter the username, password, and domain 
information. You will be authenticated on the remote server using the specified credentials. 

• Smart Card. Select this option to authenticate using a smart card. When connecting to the 
remote server, insert a smart card into the card reader and then enter a PIN when 
prompted. 

• Single Sign-On. This option will be included in the list only if the Single Sign-On module is 
installed during Parallels Client installation. Select this option to use local system credentials 
to connect to the remote server. 

Note for Administrators: The allowed authentication type(s) must be specified in the RAS Console in 
Connection / Authentication. 

Display 

The Display tab page allows you to configure display options. 
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In the General Options section, specify the general display properties, including color depth and 
screen size. If you would like to specify a custom screen size, select Custom in the drop-down list 
and then specify the size using the Width and Height fields. 

If you have more than one monitor connected to your computer, select the Use all monitors for 
Desktop session option to use all of them to display the remote desktop. 

Specify the Desktop Options as follows: 

• Smart-sizing. Desktop smart sizing will scale the RDP desktop to fit the connection window. 

• Embed desktop in launcher. Enable this option to access the published desktop inside 
Parallels Client. 

• Span desktop across all monitors. Enable this option to span the published desktops across 
all connected monitors (if you have more than one). 

• Display connection bar in full screen mode. Enable this option to show the connection bar 
when connecting in full screen mode. 
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Local Resources 

Use the Local Resources tab page to configure how local resources are handled by the remote 
desktop. 

 

You can see that these are the same options that are available when using a standard Microsoft 
Remote Desktop Connection. The options are self-explanatory, so you can set them according to 
your preferences. 
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Programs 

The Programs tab page allows you to specify a program that will be started automatically on the 
remote computer when you establish a connection with it. 

 

Select the Start the following program on connection option and then specify the Program path 
and file name and Start in the following folder options. 
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Experience 

The Experience tab page allows you to tweak the connection speed to optimize the performance 
of the connection with the remote computer. 

 

If you are connecting to a remote computer on a local network that runs at 100 Mbps or higher, it is 
usually safe to have all of the experience options turned on. It is also recommended to enable 
compression to have a more efficient connection. 

Network 

Use the Network tab page to configure a proxy server if you have to use one to connect to the 
remote computer. 

To configure a proxy server, select the Use proxy server option and then select the protocol from 
the following list: 
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• SOCKS4. Enable this option to transparently use the service of a network firewall. 

• SOCKS4A. Enable this option to allow a client that cannot connect to resolve the destination 
host’s name to specify it. 

• SOCKS5. Enable this option to be able to connect using authentication. 

• HTTP 1.1. Enable this option to connect using the standard HTTP 1.1 protocol connections. 

Specify the proxy host domain name or IP address and the port number. 

For SOCKS5 and HTTP 1.1 protocols, select Proxy requires authentication and enter user 
credentials. 

Authentication 

Use the Authentication tab page to specify what happens if server authentication fails. 

In the If authentication fails drop-down list, select one of the following options: 

• Connect. The user can ignore the certificate of the server and still connect. 

• Warn. The user is alerted about the certificate and still has the ability to choose whether to 
connect or not. 

• Do not connect. The user is not allowed to connect. 

Advanced Settings 

The Advanced Settings tab page allows you to customize the default behavior or Parallels Client. 

You can specify the following properties: 

• Connect to console. This option is used for administration of a Remote Desktop Session Host 
server. It acts as if a standard Remote Desktop connection is initiated from the command line 
with the /admin option. 

• Network Level Authentication. Select this option to enable network level authentication, which 
will require the client to authenticate before connecting to the server. 

• Redirect POS devices. Enables the Point of Service (POS) devices such as bar code scanners 
or magnetic readers that are attached to the local computer to be used in the remote 
connection. 

• Use Pre Windows 2000 login format. If this option is selected, it allows you to use legacy 
(pre-Windows 2000) login format. 

Connection Advanced Settings 

Click the Connection Advanced Settings button to open the Connection Advanced Settings 
dialog. 
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In the Connection section, specify the following properties: 

• Connection Timeout. The amount of time Parallels Client will try to connect to the remote 
computer until the connection is aborted. While the connection is being established, the 
connection banner will be shown. 

• Show Connection Banner if connection is not established within. Specifies the time period 
in seconds after which the connection banner will be displayed. 

In the Reconnection section, specify the following properties: 

• Reconnect if connection is dropped. Select this option and set the number of Connection 
Retries. If a connection is dropped, the Parallels Client will automatically try to reconnect. 

• Show Connection Banner if reconnection is not established within. Specifies the time 
period in seconds after which the connection banner will be displayed. 

Override computer name. Specifies the name that your computer will use during a remote 
desktop session. If set, this will override the default computer name. Any filtering set by the 
administrator on the server side will make use of the Override computer name. 
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Configuring Global Options 
You can configure the Parallels Client global options by clicking the Tools > Options menu item. 
This will open the Options dialog. 

 

On the General tab page, specify the following options: 

• Connection Banner. Connection banner is shown when the Parallels Client is connecting to a 
server or a desktop. You can choose to have a Splash Window, a Taskbar Toast Window icon, 
or you can choose to hide the connection banner. 

• Automatically refresh connected RAS connection every. Specifies the auto refresh time 
frame for each connection. 

• Logging. Enables or disables logging and allows you to view the log file. 

• Check for updates on startup. This option is available only with administrative rights. If this 
option is selected, Parallels Client will check for available Parallels Client updates on startup. 
You can also click the button to check for updates. 
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• Single Sign-On. Single Sign-On should be enabled if you want to use your system credentials 
when connecting to a Farm. 

The Advanced Settings tab page allows you to configure advanced options. 

 

The following advanced options are available: 

• Hide Launcher when application is launched. If this option is enabled, the launcher will be 
minimized in the system tray after an application is launched. 

• Always on Top. With this feature enabled, other applications will no longer mask the launcher. 

• Do not warn if server certificate is not verified. When connected over SSL, and the 
certificate is not verified, a warning message will be displayed. You can disable this warning 
message by enabling this option. 

• Show folders page. Enabling this option will show the available folders while showing the 
hierarchy of the application groups as configured on the server. 

• Minimize to tray on close or escape. Enable this feature to place the Parallels Client into the 
System Tray when you click on the Close button or hit escape. 
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• Launch automatically at Windows startup. This option will place a shortcut in the start menu 
folder of the client and the Parallels Client will launch automatically on Windows startup. 

• Add RAS Connection automatically when starting web or shortcuts items. This option will 
add the connection preferences in the Parallels Client when starting an item contained in a 
connection that is not yet listed. 

• Don't show prompt message for auto add RAS Connections. Enable this option to disable 
prompt messages when adding auto connections. 

• Clear session cookies on exit. When a user logs on, a Parallels Remote Application Server 
logon cookie is kept on the client side. This will allow the user to connect again with Remote 
Application Server without re-authenticating. Check this option to delete any cookies when the 
user closes the Parallels Client. 

• Close error messages automatically. When a session disconnects because of an error, the 
error is automatically dismissed after 15 seconds. 

• Show SSL icon indicator on taskbar tray. When a session connects using SSL, an icon is 
added on the taskbar tray.  Double-click on the icon and you will see your certificate 
information. 

• Automatic fonts installed (administrators only). If automatic fonts are installed on the server, 
they will be available when a session connects. 

• Swap Mouse Buttons. When enabling this setting, the mouse buttons will be swapped on the 
remote computer. 

• Redirect vendor paper sizes for RAS Universal Printing. When enabling this setting, non-
standard paper sizes which are not included in the standard options will be redirected to the 
client. Sizes may vary depending on the vendor. 

• Raw printing support. When enabling this setting, printing will still work for applications 
sending data in RAW format. 

• Convert non distributable fonts data to images. During RAS Universal Printing, if a 
document includes non-distributable fonts, each page is converted to an image. 

• Cache printers hardware information. Caching of printer hardware information locally to 
speed-up RAS universal printer redirection. 

• Cache RAS Universal Printing embedded fonts. Caching of embedded fonts locally to 
speed-up RAS universal printing process time. 

• DPI aware. This will force a published application to be DPI-aware depending on the client's 
DPI settings. This feature works on Windows 8.1 or higher. 

Using a RAS Connection 
To connect to Parallels Remote Application Server, double-click a connection in the Connections 
list (or right-click > Connect). 
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You can have multiple active connections at the same time (both Remote Application Server and 
standard RDP). To switch between active connections in Parallels Client, click a connection in the 
left pane or click the corresponding tab page in the right pane. 

Every time you connect to a remote server from Parallels Client, a session is created for the 
connection. To manage a session, select a connection in the Connections list and then click the 
Sessions menu. 

  

The menu has the following options allowing you to perform session management tasks: 

• Connect. Connect to Remote Application Server using the selected connection settings. If the 
selected connection is active, this menu item will be disabled. Depending on whether a 
connection is active or not, other menu items will also be disabled or enabled. 

Tip: Active connections have a blue monitor icon, while inactive connections have a gray monitor icon. 

• Refresh. Use this option to refresh the session and the the published resources view in the 
right pane. If there were changes on the Parallels Remote Application Server side, they will be 
reflected in the Parallels Client. You can also use the recycle icon (next to the connection 
information bar at the top) to perform the same task. 

• Disconnect. Disconnects the selected connection. 

• Logoff. Loggs off Parallels Client from the session. 

• Send Ctrl+Alt+Del. Sends the key combination to the remote computer. 

• Sessions Information. Opens the Sessions dialog that lists all active sessions. You can select 
a session and then click the Show Information button to see additional session info. 

• Disconnect All RAS Sessions. Disconnects all active Remote Application Server sessions. 

• Log Off All RAS Sessions. Logs off Parallels Client from all active Remote Application Server 
sessions. 
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• Disconnect All RDP Sessions. Disconnects all active RDP sessions. 

Another menu can be access by right-clicking an active connection  in the Connections list. The 
menu has the following items: 

• Connect. This item is disabled if the connection is currently active. 

• Refresh. Refreshes the published resources view in the right pane. 

• Connection Properties. Opens the Connection Properties dialog where you can configure 
the connection. See Configuring a RAS Connection for details (p. 22). 

• Delete. Deletes the connection. 

• Change Domain Password. Allows you to change the current user's domain password. Click 
this item to open the Logon dialog where you need to type the current password. Click OK to 
open the Change Password dialog and type a new password in both fields. Click OK to 
change the domain password. 

• Create Shortcuts for All Visible Applications. Creates shortcuts on the local desktop for all 
published applications displayed in the right pane of the main window. 

• Delete Shortcuts from Desktop. Deletes the shortcuts that were created after clicking the 
Create Shortcuts for All Visible Applications menu item. 

• Disconnect. Disconnects from Parallels Remote Application Server. 

• Log Off. Loggs off Parallels Client from the session. 

Using an RDP Connection 
After adding a Standard Remote Desktop connection, double-click it (or right-click > Connect) to 
establish a connection with the remote computer. 

You can have multiple active connections at the same time (both standard RDP and Remote 
Application Server). To switch between active connections in Parallels Client, click a connection in 
the left pane or click the corresponding tab page in the right pane. 

Right-click an active RDP connection in the Connections list to perform the following actions: 

• Connect. This item is disabled for an active connection. 

• Connection Properties. Opens the Connection Properties dialog where you can configure the 
connection. See Configuring an RDP Connection for details (p. 33). 

• Delete. Deletes the connection. 

• Smart Sizing. If enabled, smart-sizing will resize the remote desktop so it fits the available area. 

• Embed in Launcher. Click this item to move the remote desktop to a new window (it will float 
outside the main Parallels Client window). To return the remote desktop back to the Parallels 
Client window, click the menu item again. 

• Create Shortcut on Desktop. Creates a shortcut for this connection on the local desktop. 
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• Delete Shortcut from Desktop. Removes the connection shortcut from the desktop.  

Grouping RDP Connections Using Folders 

You can group standard RDP connections in the main Parallels Client window using folders. 

To create a folder and add RDP connections to it:  

1 In the main Parallels Client window, click File > Add Folder. 

2 Type a folder name. 

3 Click an RDP connection and drag it to the folder that you created. 

 

Exporting and Importing Parallels Client Settings 
You can export current Parallels Client settings to a file to have a backup or to import the settings 
into a Parallels Client installed on a different computer. The following settings are exported: 

• All existing connections including all individual connection properties. 

• Parallels Client global options. 

To export the current Parallels Client settings to a file, click File on the main menu and then click 
Export Settings. In the dialog that opens, specify a file name and a destination folder. Click Save 
to export the settings. The file is saved with the ".2xc" extension. 
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To import the settings, click File > Import Settings. In the dialog that opens, select the ".2xc" file 
and click Open. Please note that the Parallels Client settings stored in a file will override the current 
Parallels Client settings. 

Parallels Client Command Line Parameters 
Parallels Client for Windows parameters are available when launching published application and 
published desktop from the command line. 

Parameters Note 

s!='primary server' Primary Server hostname or IP address. 

b!='backup server' Secondary Server hostname or IP address. 

a!='application/desktop id' Published Application/Desktop ID. 

p!='override application params'  

t!='port' Port of the RAS Remote Application 
Serverconnection. 

u!='username' Username for the user to connect with. 

q!='password' Password for the user. 

d!='domain' ignored if user name is in UPN format Domain name. 

l!='0/1' 0 use primary server, 1 user backup server Specify value  in order to connect either to primary 
or backup server. 

m!='connection mode' (gateway mode = 0, direct 
mode 1, gateway ssl mode = 2, direct ssl = 3, 
direct rdp=4) 

Specify value for  the connection mode. 

o!='0/1' if set to 1 credentials are overwritten with 
SSO information if available 

When set to 1, credentials are overwritten with 
SSO credentials. 

i!='connection alias' Specify a connection Alias. 

c! Always ask for credentials. 

r! Reconnect if connection is dropped . 

Example: 

1 In Command Prompt, go to the location were Parallels Client is installed and run the following 
command: 
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TSClient.exe s!='2008ad1.2x.testing' a!='#50' t!='80' d!='2x.testing' 
u!='testerjm'q!='123456'  m!='0' 

 

Running the above command will launch Published application with ID92, for user testerjm. 



 

Index 
 

A 
Adding a New Connection - 20 
Advanced Parallels Client Installation - 17 
Advanced Settings - 32, 40 
Authentication - 32, 40 

C 
Configuring a RAS Connection - 22 
Configuring an RDP Connection - 33 
Configuring Global Options - 42 
Connecting to Parallels Remote Application 

Server - 13 
Connection - 23, 34 

D 
Display - 26, 35 

E 
Experience - 31, 39 
Exporting and Importing Parallels Client 

Settings - 47 

G 
Getting Started - 5 
Grouping RDP Connections Using Folders - 

47 

I 
Installing Parallels Client Manually - 11 
Installing Parallels Client Using an Invitation 

Email - 5 

L 
Local Resources - 30, 37 

M 
Manually Downloading and Installing Parallels 

Client - 11 

N 
Network - 31, 39 

P 
Parallels Client Command Line Parameters - 

48 
Printing - 27 
Programs - 38 

S 
Scanning - 29 
System Requirements - 5 

U 
Using a RAS Connection - 44 
Using an RDP Connection - 46 
Using Parallels Client for Windows - 20 
 

Index 


	Getting Started
	System Requirements
	Installing Parallels Client Using an Invitation Email
	Installing Parallels Client Manually
	Manually Downloading and Installing Parallels Client
	Connecting to Parallels Remote Application Server
	Advanced Parallels Client Installation


	Using Parallels Client for Windows
	Adding a New Connection
	Configuring a RAS Connection
	Connection
	Display
	Printing
	Scanning
	Local Resources
	Experience
	Network
	Authentication
	Advanced Settings

	Configuring an RDP Connection
	Connection
	Display
	Local Resources
	Programs
	Experience
	Network
	Authentication
	Advanced Settings

	Configuring Global Options
	Using a RAS Connection
	Using an RDP Connection
	Grouping RDP Connections Using Folders

	Exporting and Importing Parallels Client Settings
	Parallels Client Command Line Parameters

	Index

